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A Note Regarding Supplemental Files



Supplemental files and examples for this book can be found at http://examples.oreilly.com/0636920010371/. Please use a standard desktop web browser to access these files, as they may not be accessible from all ereader devices.
All code files or examples referenced in the book will be available online. For physical books that ship with an accompanying disc, whenever possible, we’ve posted all CD/DVD content. Note that while we provide as much of the media content as we are able via free download, we are sometimes limited by licensing restrictions. Please direct any questions or concerns to booktech@oreilly.com.

Preface



In the early days, embedded systems were built primarily by engineers in a pretty exclusive club. Embedded devices and software tools were expensive, and building a functional prototype required significant software engineering and electrical engineering experience.
With the arrival of Arduino, the open source electronics prototyping platform, things are cheaper and easier. The hardware is inexpensive (around $30), the software is free, and the Arduino environment is designed for artists, designers, and hobbyists rather than engineering professionals.
The ultimate goal of this book is to teach you how to build prototypes using Arduino. We'll offer just enough theory to help you apply your new skills to your own projects. You will also become familiar with the logic behind coding and components. We will explain every single line of code and tell you how each component is used. You will learn by completing actual projects, and the knowledge you gain will enable you to further develop your own ideas.
Most books on embedded systems are either so specialized that you need to work within the particular field or too simplistic to be interesting. Books for beginners often just teach you to blindly follow instructions; here, we aim to promote a deeper understanding and a skill set that can be applied more flexibly.
Finally, this book is meant for readers who want to learn how to build prototypes of interesting gadgets, not for those who want to build a dental X-ray machine or a microwave oven. At the same time, you will be able to apply the techniques covered in the book to make prototypes of commercial device concepts.
Embedded Systems Are Everywhere



An embedded system is a microcontroller-based device designed for a very specific purpose. Some examples include washing machines, cell phones, elevators, car brakes, GPS devices, air conditioning units, microwave ovens, wristwatches, and robotic vacuum cleaners. Unlike the user interface you're accustomed to with traditional computers, embedded systems typically do not include a display, mouse, and keyboard. Instead, you might control them via switches and foot pedals, for example.
Most embedded systems are reactive systems, operating in a continuous interaction with their environment and responding within a tempo defined by that environment. This makes them a logical choice for tasks that must react immediately, such as a car braking system.
In some cases, it can be hard to tell whether a particular system should be classified as an embedded system or a computer. For example, cell phones are starting to include more and more features typically associated with computers, but they still have much in common with embedded systems.
Why Should You Study Embedded Systems?



The world is already full of embedded systems. With reasonable effort, you can learn how to build one yourself. Turn inventions and ideas into inexpensive prototypes, automate your home by creating a fish-feeding device or controlling lighting from your computer, or build a remote-controlled surveillance camera for your yard that you can access via a computer located anywhere in the world. Artists can create interactive installations or integrate sensors into a game that you can control without touching a computer. Possible implementations are endless.
During the 2000s, the DIY meme gathered more and more popularity, as is evident with the growth of MAKE Magazine and websites such as http://www.instructables.com. The Bay Area Maker Faire, an annual DIY festival, went from 22,000 attendees in its first year (2006) to more than double that amount (45,000) in its second year. And each year, Maker Faire attendance keeps growing.
Learning embedded systems is becoming even more appealing due to the growing interest in robotics. In a 2006 Scientific American article,[1] Microsoft founder Bill Gates predicted that robotics would be the next revolution within homes, comparing the current state of the robotics industry to the computing industry in the 1970s. Gates anticipates that robots will soon become a natural part of a home, taking care of simple tasks such as vacuum cleaning, lawn mowing, surveillance, and food service. In addition, because robots can be controlled remotely from anywhere, we'll be able to use them for telepresence—viewing, hearing, and touching people and things without even having to be present.

Intelligent Air Conditioning



The common use of embedded systems is not just the stuff of science fiction or future technology. It's already here and pervasive in the home. Consider air conditioning. A smart air conditioning system adjusts itself based on measurements. How does it know when the air is thick or stale?
Air conditioners measure the temperature, humidity, and sometimes also carbon dioxide levels using sensors. A microcontroller (a small, dedicated computer) follows these measurements, and if the air is damp, for example, it activates a servo that opens an air valve, letting fresh air flow in. This type of intelligent air control system has many benefits. It saves energy, because the air conditioning system doesn't need to be used at full power all the time, and it makes working in such a space more comfortable, because there's neither a constant draft nor stagnant air. The heating and air conditioning system at your own school or job likely functions on the same principles.

Sensors, Microcontrollers, and Outputs



Embedded systems include sensors, microcontrollers, and outputs. Sensors measure conditions within a physical environment, such as distance, acceleration, light, pressure, reflection of a surface, and motion.
The microcontroller is the brain of an embedded system. It's a tiny computer, with a processor and memory, which means you can run your own programs on it. The Arduino microcontroller used in this book is programmed using a full-size computer via a USB cable, with sensors and outputs connected to the microcontroller pins.
Outputs affect the physical environment. Examples of outputs you'll learn to control in this book include LEDs and servo motors. Output devices are sometimes known as actuators.




[1] http://www.scientificamerican.com/article.cfm?id=a-robot-in-every-home



Learn Embedded Systems in a Week



This book will teach you the basics of embedded systems in just one week, during which time you'll build your first gadget. After that, you can move on to more complex projects and prototypes based on your own ideas. Within seven days, you will already be deep within the world of embedded systems.
This goal can sound immense—at least, we felt it was impossible before we became familiar with contemporary development environments. But today, many projects that once felt impossible now seem straightforward.
The purpose of this book is to teach you how to build embedded systems, and we've left out any topic that does not support the practice of building prototypes. For example, we don't cover history, movement of electrons, or complex electrical formulas. We believe it makes more sense to study these concepts after you are surrounded by your own homemade devices.
Classroom Use



We tested this book with actual students during a one-week, intensive course led by Tero Karvinen. By the end of the week, all the students in the course were able to build their own prototypes.
The students built many types of projects: a burglar alarm that can be disarmed with a wireless RFID keychain; a flower-measurement device that saves the height, humidity, and temperature of a flower to memory; a sonar device that draws an image of its distance on a computer screen; an automatic triggering device for a camera; a web-based control device for a camera; and a temperature meter observable via an Internet interface. For more examples of projects, visit http://BotBook.com/.
Feedback from the class included one common wish: a longer course with more theory. Hopefully, you will become equally hungry for more after you have learned how to build gadgets. We believe that learning electronic theory becomes more interesting after you have already built functional devices. For a complete book on electronics that begins at the beginning, see Charles Platt's Make: Electronics (O'Reilly, http://oreilly.com/catalog/9780596153748).


What You Need to Know



Being able to use a computer is a prerequisite for completing the exercises in this book. You will need to know how to install programs and solve simple problems that often pop up during program and driver installation.
We've tested the instructions in this book in Ubuntu Linux, Windows 7, and Mac OS X. You should be able to implement the instructions relatively easily for other Windows systems or other Linux distributions.
Programming skills can be helpful but are not necessary for learning embedded systems. The particular programming language you know isn't important, but being familiar with basic programming principles such as functions, if-then statements, loops, and comparisons is beneficial. It's possible to learn programming along with learning about embedded systems, but this approach could take more time. You might find it useful to consult a beginner's book on programming.
High school–level electrical theory and knowledge of voltage, current, resistance, and circuits is sufficient. Have you already forgotten this? No worries—we will revisit basic electrical theory before starting the projects.

How to Read This Book



One of our goals is to provide information in an easily digestible form. By reading this book, anyone can learn how to build impressive-looking electronic devices. Instead of splitting the book into separate sections for techniques and code, we have attempted to combine the information within six projects. This way, you will learn new things bit by bit and can immediately test them in real situations.
The beginning of each project provides learning goals and a list of necessary parts. Before building a device, you can test each part individually; applying the components usually becomes much easier once you understand their core functions. It is useful to come back to these introductory sections later, as you incorporate things you have learned into your own new applications.
We also explain each line of code. This does not mean that you should first read the explanations and continue only after you have internalized everything. We always provide the entire functional code, which you can type or download from http://BotBook.com/. Once you have succeeded in getting one version of the code to work, you'll be motivated to find out how it works or to customize it for your own purposes. When you start to build your own devices, the explanations will make it easier for you to identify the necessary sections of the provided code.
The projects are partitioned so you can test each part one step at a time. This way, it is easier to understand the function of each step and the relationships between different parts. This also helps ensure that once you have built a device, you can easily troubleshoot any problems; if something doesn't work, you can always go back to an earlier functioning phase and restart from there.
There are examples of enclosures for several projects in this book. They are useful as teaching techniques for mechanical construction and give you ideas for how to make a demonstrable prototype relatively inexpensively. You are not obligated to follow the instructions literally. You might have different parts or a better vision for the look of your device.

Contents of This Book



This book includes two introductory chapters followed by six chapters with projects. As you move through the book, you'll go from learning the basics of Arduino to completing projects with moving parts, wireless communication, and more:
	Chapter 1
	This chapter explains prototyping, including an overview of the philosophy behind it, techniques, and tools.

	Chapter 2
	This chapter familiarizes you with Arduino, the open source electronics prototyping platform used in every project in this book (except the Boxing Clock in Chapter 6).

	Chapter 3
	In this chapter, you'll learn how to use distance-finding sensors to detect when someone is trying to sneak up on you.

	Chapter 4
	This chapter uses distance-finding sensors, servos, and spare parts to make an obstacle-avoiding robot.

	Chapter 5
	This chapter combines Arduino, your computer, and distance-finding sensors to create an interactive slideshow you can control with your hands. You'll also learn about two languages for programming on the computer: Processing and Python.

	Chapter 6
	This chapter teaches you how to build a graphically rich timer clock on an Android phone. It will also serve as a primer for Chapter 8.

	Chapter 7
	In this chapter, you'll hack some remote-controlled power outlets so you can turn things on or off using a sketch running on Arduino—or even from the convenience of your desktop computer.

	Chapter 8
	This chapter combines a lot of what you've learned so far: Arduino, robotics, and cell phone (Android) programming. You'll learn how to create a remote-controlled, soccer-playing robot. You'll control it from your cell phone's built-in accelerometer; simply tilt the phone to tell the robot to move or kick a small ball!

	Appendix A
	The appendix presents tBlue, a lightweight library that makes it easy to communicate over Bluetooth between an Android phone and Arduino.




Conventions Used in This Book



The following typographical conventions are used in this book:
	Italic
	Indicates new terms, URLs, email addresses, filenames, and file extensions.

	Constant width
	Used for program listings, as well as within paragraphs to refer to program elements such as variable or function names, databases, data types, environment variables, statements, and keywords.

	Constant width bold
	Shows commands or other text that should be typed literally by the user.

	Constant width italic
	Shows text that should be replaced with user-supplied values or by values determined by context.




Using Code Examples



This book is here to help you get your job done. In general, you may use the code in this book in your programs and documentation. You do not need to contact us for permission unless you're reproducing a significant portion of the code.
For example, writing a program that uses several chunks of code from this book does not require permission. Selling or distributing a CD-ROM of examples from O'Reilly books does require permission. Answering a question by citing this book and quoting example code does not require permission. Incorporating a significant amount of example code from this book into your product's documentation does require permission.
We appreciate attribution. An attribution usually includes the title, authors, publisher, copyright holder, and ISBN. For example: "Make: Arduino Bots and Gadgets, by Kimmo Karvinen and Tero Karvinen (O'Reilly). Copyright 2011 O'Reilly Media, 978-1-449-38971-0." If you feel that your use of code examples falls outside fair use or the permission given above, feel free to contact us at permissions@oreilly.com.

We'd Like to Hear from You



Please address comments and questions concerning this book to the publisher:
	O'Reilly Media, Inc.
	1005 Gravenstein Highway North
	Sebastopol, CA 95472
	(800) 998-9938 (in the United States or Canada)
	(707) 829-0515 (international or local)
	(707) 829-0104 (fax)

We have a website for this book, where we list errata, examples, and any additional information. You can access this page at: http://oreilly.com/catalog/9781449389710. All code examples and programs are available on http://BotBook.com.
To comment or ask technical questions about this book, send email to: bookquestions@oreilly.com.
Maker Media is a division of O'Reilly Media devoted entirely to the growing community of resourceful people who believe that if you can imagine it, you can make it. Consisting of MAKE Magazine, CRAFT Magazine, Maker Faire, and the Hacks series of books, Maker Media encourages the Do-It-Yourself mentality by providing creative inspiration and instruction.
For more information about Maker Media, visit us online:
	MAKE: www.makezine.com
	CRAFT: www.craftzine.com
	Maker Faire: www.makerfaire.com
	Hacks: www.hackszine.com


Safari® Books Online



Safari Books Online is an on-demand digital library that lets you easily search over 7,500 technology and creative reference books and videos to find the answers you need quickly.
With a subscription, you can read any page and watch any video from our library online. Read books on your cell phone and mobile devices. Access new titles before they are available for print, and get exclusive access to manuscripts in development and post feedback for the authors. Copy and paste code samples, organize your favorites, download chapters, bookmark key sections, create notes, print out pages, and benefit from tons of other time-saving features.
O'Reilly Media has uploaded this book to the Safari Books Online service. To have full digital access to this book and others on similar topics from O'Reilly and other publishers, sign up for free at http://my.safaribooksonline.com.
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Chapter 1. Introduction



IN THIS CHAPTER
Building Philosophy
Reusing Parts
Buying Components
Useful Tools
Electronic Circuit Theory Review
This chapter will get you started building and designing prototypes for embedded systems. You will learn basic principles that you'll follow in Chapter 2 and Chapter 3 as you build the Stalker Guard and Robot Insect. Prototypes in this book are just the beginning. Once you know the techniques, you'll be able to build prototypes for your own inventions.
Building Philosophy



When you break a programming problem down into smaller pieces, be sure to test and validate each piece as you go. If you don't do this, you could find yourself wildly off track by the time you've gotten through a few pieces.
Prototype



This book provides techniques for building prototypes, or test versions of a device. A prototype such as the one shown in Figure 1-1 provides a proof of concept—a concrete realization of a device's intended functions.
Try to finish a functional prototype as quickly as possible. Once you've documented a working prototype, you can build in improvements in later versions.
You can make a working end result by stripping out unnecessary functions and taking shortcuts. If it makes testing quicker, use rubber bands and duct tape when you have to. Don't try to optimize your code in the first version.
It's much easier to build an impressive version once the first prototype is finished. Usually, you'll find that many challenging problems you face in the prototype don't even need to be solved for the final version. In the same way, building a prototype can reveal new opportunities for development.
[image: Jari Suominen testing a prototype made of Legos]

Figure 1-1. Jari Suominen testing a prototype made of Legos

Having a prototype can also help you secure funding for your project. Who would you believe more: someone who talks about a walking robot, or someone who has actually built one?

Start with Hello World



Starting a project with Hello World is usually a good idea, because it's the simplest possible program. Typically, Hello World will print a row of text to a computer screen or blink an LED. It is used for testing to make sure the development environment works.
Note
How does Arduino say "hello" to the world? By blinking an LED. You'll learn more in Chapter 2.

If your next, more complicated iteration doesn't work, you can search for the cause of the problem within the added code. Hello World lets you know that the microcontroller, development environment, interpreter, and USB port all function correctly.
[image: Juho Jouhtimäki and Elise Liikala building a motion-sensitive soft toy]

Figure 1-2. Juho Jouhtimäki and Elise Liikala building a motion-sensitive soft toy


Build in Small Steps



Complex problems (see Figure 1-2, Figure 1-3, and Figure 1-4) are hard to solve, but you can usually make them easier by breaking them down into smaller pieces. You can then solve the problem one manageable piece at a time.
A student of ours once built a burglar alarm after studying embedded systems for a week. The alarm buzzed whenever an infrared sensor detected movement. Users could log into the system wirelessly by presenting an ID in the form of a keychain. Once the system approved the login, the user could then move freely in the space without triggering an alarm.
[image: Welding a robot hand]

Figure 1-3. Welding a robot hand

A project like this can sound quite complex to a novice, but it really consists of three clearly separate components (motion detector, buzzer, RFID reader). First, the student programmed and tested the motion sensor. That section was finished when the program could detect movement and sound the alarm.
The three components of the system do not affect one another in any way, and the only unifying factor is the code. Program code can check with the motion detector to determine whether movement is present and, if so, it can switch on the buzzer.
[image: Jari Suominen's strobo owl, which uses aesthetics from printed circuit boards and components]

Figure 1-4. Jari Suominen's strobo owl, which uses aesthetics from printed circuit boards and components


Test in Steps



"I wrote the code for a singing and dancing robot that can walk up stairs. The code is 30,000 lines long. I just tried compiling it, but it doesn't work. Do you have any advice?"
Conduct testing as early as possible. If, for example, you build a walking robot, the first thing to test is whether you can make the servo motor move. The next test can make the servo move back and forth.
After you have tested the functionality of a specific version of code, save it separately from the version you are working on.

Revert to the Last Known Good Version



When you have developed your code into a confusing and nonfunctional state, the solution is easy. Go back to the last working version.
More specifically, go back to a working stage when the situation was already becoming confusing. This method removes the problem areas and lets you start over with a functional clean slate, helping you isolate what went wrong.

Read the Friendly Manual



RTFM is an old Internet acronym. (Actually, the F is not always friendly, so we usually stick with just RTM.) The point of the expression is that most answers are out there, written in a manual. When you're surrounded by parts (see Figure 1-5), you're going to need answers.
Friends and students sometimes wonder how we know so much. How do we know the Arduino operating voltage or the way to install SSL encryption to the Apache web server?
[image: Mikko Toivonen, surrounded by robots and microcontrollers]

Figure 1-5. Mikko Toivonen, surrounded by robots and microcontrollers

The answer is easy. You can find instructions for almost anything if you know where to look.
Instructions don't always come with devices and parts, but you can often find them on manufacturer's web pages (such as http://www.parallax.com) or by searching in Google. Good search terms include device names (e.g., "ping ultrasonic sensor") or a sequence of numbers on a circuit board (e.g., "H48C"). You could also combine a search sequence with a technology—for example, "H48C arduino." Some web pages are devoted specifically to Arduino—for example, http://arduino.cc and our site, http://BotBook.com.

Document



Most things appear easy once you know them. The details of a project seem obvious on the day you complete them ("of course I remember when I programmed the 16-servo walker"). But a week after building, coding details begin to disappear from your memory. After a year or so, it can be hard for someone who builds many projects to remember anything about a specific one.
[image: Jenna Sutela and David Szauder demoing functions of a wearable prototype]

Figure 1-6. Jenna Sutela and David Szauder demoing functions of a wearable prototype

For this reason, it is worthwhile to document all projects. Typing notes avoids the potential problem of illegible handwriting, and shooting stages with a digital camera provides an accurate visual snapshot of each stage.
You might also consider publishing your results on the Web. Some projects that would otherwise be collecting dust in your drawer might actually be useful to others. You might even find your own instructions (long since forgotten) when looking to solve a new problem with similar logic. Two sites where you can publish projects are Make: Projects (http://www.makeprojects.com) and Instructables (http://www.instructables.com).



Reusing Parts



Prototype mechanics (see Figure 1-6) need all kinds of parts, such as frames, limbs, and joints. Finding appropriate materials can seem daunting. Customizing more complicated parts using homebrew methods isn't always easy, and even basic materials—such as lightweight and sturdy metal plates—can be significantly expensive at hardware stores.
As a starting point, we recommend using recycled parts. Old devices are filled with usable materials, so remove all salvageable parts before you throw them away.
Warning
Not every device is safe to salvage: for example, a CRT (Cathode Ray Tube) TV retains a hazardous voltage for a long time after you unplug it from the wall.

One additional perk that comes with using recycled parts is a unique aesthetic. Old parts often have interesting shapes, curves, and worn areas (Figure 1-7).
[image: An assortment of parts that can be reused]

Figure 1-7. An assortment of parts that can be reused

Computer DVD drives and hard drives can make great frames for robots, because their covers are often made of lightweight, easily drillable, and sturdy material. You can also remove DC (direct current) motors and gears from DVD drives. Nowadays, there is more readily available computer junk than you can gather and store in your home. Educational institutions and corporations are particularly good sources, as they're continuously throwing out old devices.
Flea markets can also hold great finds. Mechanical typewriters deserve a special mention here. Though they are relatively hard to disassemble, they house an unbelievable amount of small springs, metal pieces of different shapes, and screws.
Disassemble devices as soon as you find them and then discard or recycle unnecessary parts. This way, you'll avoid turning your home into a graveyard of retired devices, and more importantly, the parts will be immediately usable when you really need them. When you are searching for a suitable attachment piece for a servo, you probably don't want to start a six-hour disassembly operation. Parts usually won't find a new purpose until you've removed them from the original device, at which point inspiration might strike. You might even wonder how a specific "whatchamacallit" fits a new purpose so perfectly.
When you begin working on some difficult new mechanism, think about where you might have seen something similar. You'll often find everyday solutions to many problems. For example, parts purchased from bicycle or automotive shops can sometimes work in other projects. Figure 1-8 shows a hand with fingers that are moved with servo motors; every joint in each finger bends. The fingers were made by attaching sections of a steel pipe to a bicycle chain. They bend when a brake cable is pulled down. Typewriter parts welded to the opposite side of the structure pull the fingers back into a straight position.
[image: Robot hand made of junk]

Figure 1-8. Robot hand made of junk

Also keep your eyes open in military surplus stores, where you can find inexpensive, sturdy, and personalized enclosures for prototypes. Various parts and accessories in these shops can also, with a bit of creativity on your part, give devices significantly more street cred. For example, Figure 1-9 shows a porcupine robot cover built from an MG/42 machine gun ammunition belt.
[image: Porcupine robot cover made from a machine gun ammunition belt]

Figure 1-9. Porcupine robot cover made from a machine gun ammunition belt


Buying Components



If you can't find exactly what you're looking for in recycled materials, order component parts online. Many unique components can't be found locally at all, or will be overpriced if you do find them. Luckily, comparing prices and ordering online is quite easy.
Because online stores often change, make sure to check the latest links available at http://BotBook.com/.
We purchased parts for this book from a variety of sources. We ordered most of the sensors and full-rotation servos from the United States. Arduinos and some of the sensors came from Sweden. We rounded up ordinary components—such as resistors, LEDs, and wiring—from electronics stores in Helsinki. Standard servos came from a Finnish online store specializing in radio-controlled cars and airplanes. Some servos were ordered from Hong Kong. Here are a few sources to consider:
Warning
If you're in the US, you will generally be able to find all the parts you need within the country. However, if you ever need to order large amounts of something (such as hundreds or thousands of LEDs), you may find yourself purchasing from an overseas supplier (for example, many bulk LED sellers on eBay ship from Hong Kong).
When choosing a country to order from, take into consideration customs rules and additional fees incurred by international orders. Shipping costs can also be high in some countries, and some companies won't even ship overseas. Also, consumer protections might not apply to international orders in the event that the package is broken or the product is different from what you ordered.
Regardless of all the scaremongering, ordering internationally usually works out without major problems. We have received everything we have ordered, and the products haven't had any major faults.

	Maker SHED
	MAKE Magazine's store can be found online at http://www.makershed.com/ and in real life at Maker Faire (http://makerfaire.com/). Maker SHED carries Arduinos, project kits, tools, parts bundles, books, and much more. Keep on eye on Maker SHED for special parts bundles or kits dedicated to projects in this book.

	Adafruit Industries
	The Adafruit store (http://www.adafruit.com) specializes in Arduinos, microcontrollers, electronic and robotic components (including servo motors), tools, and kits. It also has a comprehensive set of Arduino tutorials and produces its own Arduino-compatible boards such as the Boarduino.

	SparkFun Electronics
	Among many other things, SparkFun (http://www.sparkfun.com/) is a great source for all kinds of sensors—from light and temperature sensors to accelerometers and gas sensors. What's more, it sells the sensors mounted to breakout boards so you can easily connect them to an Arduino without having to do tricky surface-mount soldering. SparkFun has much more, including tools, parts, and Arduinos.




Useful Tools



When building prototypes, you're going to need some tools (Figure 1-10). The following sections cover the tools that we have found a consistent need for. They are not all mandatory, but depending on your own projects or needs, you may have a use for them in the future.
[image: Wire stripper and side-cutter pliers are sufficient for building prototypes on a prototyping board]

Figure 1-10. Wire stripper and side-cutter pliers are sufficient for building prototypes on a prototyping board

Hearing Protectors and Safety Glasses



When using power tools, you must cover your ears with proper hearing protectors and wear safety glasses to protect your eyes from harmful flying debris and material fragments (Figure 1-11). Note that metal can fly forcefully, even when you're cutting or bending with pliers.
[image: Hearing protectors and safety glasses]

Figure 1-11. Hearing protectors and safety glasses


Needlenose Electronics Pliers



You should immediately purchase good needlenose pliers (Figure 1-12), which can be used to grab small components and parts. The tip for the pliers should be sharp enough to fit into even the smallest of spaces.
[image: Needlenose electronics pliers]

Figure 1-12. Needlenose electronics pliers


Diagonal-Cutter Pliers



Diagonal-cutter (or side-cutter) pliers, shown in Figure 1-13, are used for cutting wires and are also suitable for other small cutting jobs. Always keep at least one set of side cutters in good shape, and use a secondary pair for tasks that cause more wear.
[image: Diagonal-cutter pliers]

Figure 1-13. Diagonal-cutter pliers


Metal Saw



A metal saw is a basic, functional tool for shaping and cutting metal (Figure 1-14). Keep a spare blade on hand to keep promising building processes from being interrupted by a broken blade.
[image: Metal saw]

Figure 1-14. Metal saw


Wire Strippers



Wire strippers are used to remove the plastic around a wire to expose a conducting metal within specific areas. Do not use your teeth to strip wires! It is much more expensive to fix dental enamel than to spend just a few dollars on good wire strippers. The adjustable wire strippers on the left side of Figure 1-15 are much more useful than the multigauge model on the right, but they're not as common.
[image: Wire strippers]

Figure 1-15. Wire strippers


Screwdrivers



You'll need many different types of screwdrivers, especially when opening devices. Using the wrong screwdriver tip for a particular screw could destroy either the screw or the screwdriver and is just not worth the potential damage. The easiest and most economical thing to do is to buy a kit that comes with a handle and various attachable bits (Figure 1-16). Many electronic devices require a Torx driver and can't be opened with a flat- or Phillips-head screwdriver.
[image: Screwdriver kit with a variety of bits]

Figure 1-16. Screwdriver kit with a variety of bits


Alligator Clips



Alligator clips (Figure 1-17) can be useful for quickly connecting components and cables. They can also connect multimeter probes, enabling hands-free measurements.
[image: Alligator clips]

Figure 1-17. Alligator clips


Electric Drill



You'll need an electric drill for many projects. A hammer drill, shown in Figure 1-18, is also suitable for drilling into concrete, but a rechargeable cordless drill is easier to handle.
A drill bit can break easily, especially when you're drilling metal with thin bits, so you must wear eye protection when working with a drill. Always position the drill directly into the hole; drilling at an angle will bend the bit and cause it to break under rotation.
[image: Electric drill]

Figure 1-18. Electric drill


Leatherman



A portable handy tool such as a Leatherman (Figure 1-19) is useful during several phases of project building. In this case, it makes sense to invest in the name-brand tool rather than buying cheap imitations. A high-quality multipurpose tool can withstand heavy use, and its individual parts function in the same way as separate tools.
[image: Leatherman]

Figure 1-19. Leatherman

Note
Maker SHED sells an assortment of MAKE-branded Leatherman Squirt tools, such as the MAKE: Circuit Breaker Leatherman, a set of electronics tools that can fit on a keychain. See http://www.makershed.com/SearchResults.asp?Search=leatherman for more information.


Mini Drill



A mini drill (Figure 1-20) is not absolutely necessary, but it makes many tasks easier. Compared to an electric drill, a mini drill is lightweight and relatively precise to work with.
By using an appropriate bit, you can use a mini drill for drilling, sanding, sharpening, shining, cutting, and more. Of course, it doesn't replace a normal drill, because it doesn't have sufficient torque for drilling larger holes.
[image: Mini drill]

Figure 1-20. Mini drill


Headlamp



A headlamp (Figure 1-21) can be handy for focusing light in the direction you're working. Additional light is useful to have, even in well-lit spaces.
[image: Headlamp]

Figure 1-21. Headlamp


Hot-Glue Gun



A hot-glue gun (Figure 1-22) can adhere items together quickly. The resulting connection is not necessarily very strong, and glued items can bend away from each other, but it works sufficiently well in many prototyping phases. In addition, the fact that hot glue hardens quickly, and items glued with it can be (at least in theory) removed from each other relatively easily, can make the building process less stressful. Still, hot glue is not a replacement for Blu-Tack, and another downside is that if you're unsuccessful in your first attempt to join items together using hot glue, you'll usually need to scrape and shine the surfaces before trying again.
[image: Hot-glue gun]

Figure 1-22. Hot-glue gun


Nail Punch and Hammer



Drilling metal at home without a drill press can be quite challenging, especially with smooth metal surfaces on which a bit can slide and go through the wrong spot. A nail punch (Figure 1-23, left) can fix this problem. It can create a small dent on the spot where you want to drill a hole, making drilling much easier.
A hammer is a useful tool in its own right, but it's not always the right tool for the job. If you have something to dislodge or to set in place, look for a gentler tool first, so you don't break your project into many little pieces. As Abraham Maslow said, "I suppose it is tempting, if the only tool you have is a hammer, to treat everything as if it were a nail."
[image: Nail punch and hammer]

Figure 1-23. Nail punch and hammer


Soldering Iron



A soldering iron (Figure 1-24) joins metal sections of components together with molten metal (usually lead, but lead-free solder is available as well). The tip of a soldering iron must be sufficiently thin to enable precise attachment of small parts. Irons with a built-in thermostat are more expensive, but having the capability to adjust the temperature lessens the likelihood of destroying more sensitive components. You will learn the basics of soldering in Chapter 3.
[image: Soldering iron]

Figure 1-24. Soldering iron


Multimeter



A multimeter (Figure 1-25) is used for measuring current, voltage, and resistance. You can use it to test a value of a resistor or whether two sections of a circuit are connected. You also can test the condition of a battery by measuring its voltage.
[image: Multimeter]

Figure 1-25. Multimeter

The multimeter shown in Figure 1-25 has two ranges for measuring voltage: DC (direct current) and AC (alternating current). All Arduino circuits in this book use direct current. The correct measurement range for voltage and resistance is the smallest possible range onto which measured readings can fit.
A continuity test works technically in the same way as measuring a value of a resistor. Instead of displaying a resistance value, the continuity test beeps when an unrestricted flow of electricity is detected between two measurement probes.
Figure 1-26 and Figure 1-27 illustrate some common uses for a multimeter. The Interactive Painting project in Chapter 5 covers measuring resistance in more detail.
[image: The most common functions of a multimeter]

Figure 1-26. The most common functions of a multimeter

[image: Studying a remote controller by measuring a voltage difference between two terminals of a button]

Figure 1-27. Studying a remote controller by measuring a voltage difference between two terminals of a button



Electronic Circuit Theory Review



We'll end this chapter with just enough theory to get you started with the practice.
Voltage Creates an Electrical Current



Voltage refers to a difference in electrical potential between two parts of a circuit. For example, the terminals of a battery can have a 9-volt voltage between them.
If two parts of a circuit with different electrical charges are connected, voltage potential creates a current flow. For example, current will start flowing through a lamp that is connected between the two terminals of a battery, causing the lamp to light up.
A unit of voltage is a volt (V). The Arduino microcontroller used in this book functions with a minimum 7V and maximum 12V power adapter (or it can be powered from a 5V USB connection). Voltages inside computers are within a similar range. US AC sockets provide 110 volts and European AC sockets provide 230 volts.
A lamp will be brighter with a 9V battery than with a smaller 4.5V battery. Larger voltage creates a larger current. If a component is used with a voltage higher than what it is rated for, it will usually burn out. If you supply 5 volts to an LED that is rated for 2.4 volts, it will probably make a popping sound, release a little smoke, and cease to function. A running joke among electrical engineers and technicians is that once you've released the "magic smoke" inside an electronic component, you can't put it back in.[2]

A Resistor Resists the Flow of Current



If a resistor is added between a lamp and a battery, the lamp will be dimmer. A resistor resists the flow of current.
All components create at least a bit of resistance. A filament of an incandescent light bulb is sufficient by itself to resist the current flow.
Note
A resistor may be all that's needed to avoid releasing the magic smoke inside an LED. For example, a 1 kOhm resistor is generally more than sufficient to protect a red LED. If you have the specifications for your LED, you can calculate the value of the resistor.
Evil Mad Scientist Laboratories has a handy papercraft pocket LED calculator that you can print out and carry with you: http://www.evilmadscientist.com/article.php/ledcalc.


Short Circuits Are Dangerous



If you bridge a battery's positive and negative terminals with a wire, it forms a short circuit. The current flows rapidly through the wire, and the wire and battery will both become warm and may possibly leak or explode. Why do we mention this? Because it's possible to create a short circuit in your own projects if you don't use the correct resistor values. When you follow the instructions to build a project, you must be sure to use the resistor values specified to avoid creating the hazardous condition that comes with a short circuit.

Closed Circuits Allow Electricity to Flow



When a device is powered, its circuit is closed and electricity will flow through the device. An open circuit means that electricity cannot flow through a device. For example, a device that is shut down by its power switch is an open circuit. Electricity can't flow when the circuit is opened by the switch.
Figure 1-28 shows a closed circuit: two batteries powering an LED. The magic smoke didn't come out because the batteries and LED are well matched: the LED has a voltage of 2.6V, which is more than the voltage delivered by two AA rechargeable batteries. Standard AA batteries (1.5V each) might overpower the LED. Still, if you intended to run this circuit for hours on end, it would be advisable to include a low-rated resistor, even a 10 or 100 Ohm.
[image: Simple closed circuit powering an LED]

Figure 1-28. Simple closed circuit powering an LED


Ground = Zero Voltage Level



To make it easier to discuss topics related to voltage, a single point in a circuit is usually compared to the negative terminal of a power supply. The voltage level of a negative terminal is 0V, against which all other points of the circuit are measured. For example, the positive terminal of a 9V battery can be said to have 9V of voltage.
[image: Symbol for ground]

Figure 1-29. Symbol for ground

Ground has many names, all of which mean the same thing: 0V, minus terminal, earth, and GND. Black wire is often used to connect to the ground (red is used for positive voltage). In a circuit, ground is marked with its own symbol (shown in Figure 1-29) to avoid having to always draw a line to the minus terminal.
In this chapter, we've covered prototyping principles, techniques, and tools, and reviewed some basics of electrical theory. Now we'll move on to Chapter 2, where we introduce Arduino, the open source prototyping platform that will be the brain of your projects.



[2] http://en.wikipedia.org/wiki/Magic_smoke



Chapter 2. Arduino: The Brains of an Embedded System



IN THIS CHAPTER
Why Arduino?
Starting with Arduino
Hello World with Arduino
Structure of "Hello World"
Arduino Uno
Arduino Nano
In this chapter, you'll compile a program you have written onto an Arduino microcontroller, a small computer that acts as the brains of an embedded system. Arduino, an easy-to-learn hardware and software development environment and prototyping platform, is the foundation for the projects we'll complete in upcoming chapters.
A microcontroller is a small computer with a processor and memory that controls the functions of many everyday devices. Some microcontrollers are designed to connect easily to a computer for programming for specialized purposes. Arduino is an example of one of these easy-to-program microcontrollers.
Microcontrollers make it easier to build electronic devices because you can control their functions via code. Microcontrollers can control and interpret forms of both input and output. For example, you can flicker an LED by connecting it to a specific Arduino pin with code that instructs it to switch the current on for one second and then off for one second. The LED is an example of an output, which you could then control using a sensor, button, switch, or any other form of input. Naturally, most programs do many other, more sophisticated tasks. Microcontrollers enable us to solve quite complex problems step by step.
Why Arduino?



The most suitable microcontroller choices for a beginner are Basic Stamp and Arduino. Basic Stamp has existed since the early 1990s and has become popular among hobbyists. It uses the Basic programming language, which is easy to use but somewhat limited compared to the C language used by Arduino.
Functionally, Arduino is quite similar to Stamp, but it solves many problems that Stamp has traditionally faced. One significant feature for hobbyists is Arduino's lower cost: the basic Arduino starting package is approximately a quarter of the price of a comparable Stamp package. And, despite its cheaper price, Arduino has a more powerful processor and more memory.
Arduino is also smaller than Stamp, which is beneficial in many projects. The Arduino Uno model (see Figure 2-1, left) is slightly smaller than the Stamp, but the tiny Arduino Nano (Figure 2-1, right) is about the same size as the Stamp module that sits on the Stamp board (just above the serial port in Figure 2-2). For comparison, Figure 2-2 shows the Stamp and the Nano next to each other.
[image: Arduino Uno (left) and Arduino Nano (right)]

Figure 2-1. Arduino Uno (left) and Arduino Nano (right)

[image: Basic Stamp (left) and Arduino Nano (right)]

Figure 2-2. Basic Stamp (left) and Arduino Nano (right)

One final asset is that the Arduino programming environment is based on open source code and can be installed on Windows, Mac OS X, and Linux.


Starting with Arduino



Arduino is available in a few different models. This book covers the aforementioned Arduino Uno and Arduino Nano. Uno is an inexpensive (around $30) and sturdy basic model, and is the most current version of the board. It was released publicly in September 2010 and is the successor to the Arduino Diecimila and Arduino Duemilanove. Nano is significantly smaller, but more fragile and slightly more expensive ($35). Both models are described in a bit more depth at the end of this chapter.
First, you have to buy an Arduino and a compatible USB cable. Uno and Nano communicate to your computer via USB (for uploading new programs or sending messages back and forth). They can also take their power over USB. Uno uses a USB-B cable and Nano uses a Mini-B, and each connects to the computer with a USB-A male connector. All three connectors are shown in Figure 2-3.
Note
Chapter 8 includes a project that uses Bluetooth. Although there is an Arduino model with built-in Bluetooth (Arduino BT), a more flexible option when you're creating Bluetooth projects with Arduino is to use a third-party Bluetooth adapter, such as SparkFun's Bluetooth Mate (http://www.sparkfun.com/products/10393). This will allow you to use the Bluetooth module with different projects, or to replace Bluetooth in one of your projects with another type of wireless module such as an XBee radio.

[image: Arduino USB cables: Mini-B, USB-A, and USB-B]

Figure 2-3. Arduino USB cables: Mini-B, USB-A, and USB-B

Installing Arduino Software



Next, you need to install the Arduino development environment for your operating system and compile the first test program. This "Hello World" code is the most important part of getting started with a new device. Once you are able to compile simple, light-blinking code in Arduino, the rest is easy.
The examples in this book were tested with version 0021 of the Arduino development environment. If you decide to use some other version, the installation routine might differ. If you are using an operating system other than Windows, Ubuntu Linux, or Mac OS X, or an Arduino other than Uno or Nano, look for installation instructions at http://arduino.cc/. And remember that you will find all complete code examples, links, and program installation packages at http://BotBook.com/.
Windows 7



Here's how to get up and running under Windows 7:
	Download the Arduino development environment from http://arduino.cc/en/Main/Software and unzip it to the desired folder by clicking the right button and selecting "Extract all."

	Connect the USB cable to your computer and to the Arduino's USB port. The Arduino LED should light green.

	Windows will search for and install the necessary drivers automatically. It notifies you when the installation is complete. If Windows does not locate the driver:
	Open Device Manager by clicking the Start Menu, right-clicking Computer, choosing Properties, and then clicking Device Manager in the list of options on the left.

	Locate Arduino Uno in the list of devices (it should be in the section called Other Devices). Right-click it and choose Update Driver Software.

	Choose "Browse my computer for driver software."

	Navigate to the Arduino folder you extracted, select the drivers subdirectory, and press Next.

	If prompted to permit the installation of this driver, choose "Install this driver software anyway."






When the driver is successfully installed, you'll see the dialog shown in Figure 2-4.
[image: Drivers installed]

Figure 2-4. Drivers installed


Windows XP



In general, installation for most Windows XP programs is pretty similar to Windows 7, but Arduino is an exception. If you have XP, start by downloading the Arduino development environment, extracting the file to a location on your computer, and connecting the Arduino to your computer as described in the previous section. Then follow these additional instructions:
	Windows opens the Found New Hardware Wizard.

	Select "Install from a list or specific location" in the window and press Next.

	Deselect the checkbox in "Search removable media" and check the box "Include this location in the search." Navigate to the Arduino folder you extracted, select the drivers subdirectory, and press Next. If you are using an older model of Arduino, or the Nano, you may need to choose the drivers/FTDI USB Drivers subdirectory instead.

	Click Finish.




Ubuntu Linux



Though you can install Arduino on Ubuntu and other Linux environments using graphical user interface tools, the following steps use the Terminal (Figure 2-5) to simplify the instructions.
Note
Before you try to install Arduino on Linux, consult the Arduino FAQ (http://arduino.cc/en/Main/FAQ#linux) for links to the latest instructions.

Open the Terminal by choosing Applications→Accessories→Terminal. The dollar sign at the beginning of the following command lines is the command prompt created by the computer; do not type the dollar sign, just the characters that follow it.
We tested this installation process with Ubuntu 9.04, but it should also function (with minor alterations) with other versions.
[image: Command line]

Figure 2-5. Command line

Start using the universe program repository, which includes free, open source programs, with publicly available source codes:
$ sudo software-properties-gtk --enable-component=universe
When asked by sudo, type your password. The command after sudo will be executed using root user privileges.
Update the available software list:
$ sudo apt-get update
Now it's time to install dependencies: all the programs the Arduino development environment requires to function, including Java (openjdk) and programming tools for the AVR chip gcc-avr, avr-libc, and avrdude. New 64-bit computers also require the 32-bit compatibility library ia32-libs.
$ sudo apt-get install --yes gcc-avr avr-libc avrdude openjdk-6-jre
$ sudo apt-get install --yes ia32-libs
Next, download and open the Arduino development environment from the official Arduino home page (http://arduino.cc/en/Main/Software), where you'll find two packages: "Linux (32bit)" and "Linux (AMD 64bit)." Newer computers are based on 64-bit technology. If you don't know which package to download, use the uname-m command to determine whether your computer is a newer 64-bit model (x86_64) or an older 32-bit model (i386).
Uncompress the software package you downloaded (this will create an arduino-version directory under your current working directory):
$ tar -xf ~/Downloads/arduino-*.tgz
Start the Arduino development environment. Because you will execute the command from a specific folder, define the whole path to that folder:
$ ./arduino
The Arduino development environment will start.

Mac OS X



Here's how to get up and running under Mac OS X:
	Download the Arduino development environment from http://arduino.cc/en/Main/Software and open the .dmg file.

	A new Finder window appears with three icons (Arduino, a link to your Applications folder, and the FTDI USB serial driver package).

	Drag the Arduino icon to your Applications folder.

	If you are using a version of Arduino prior to the Uno, install the FTDIUSBSerialDriver package.

	When you connect the Arduino, you may see the message "A new network interface has been detected." Click Network Preferences and then click Apply. You can close the Network Preferences when you are done.






Hello World with Arduino



Now you're ready to upload your first Arduino program. Open the Arduino development environment:
	Windows
	Double-click the Arduino icon (you'll find it inside the Arduino folder that you extracted earlier).

	Linux
	Change directory to the Arduino folder and run Arduino:
$ cd arduino-0021
$ ./arduino

	Mac OS X
	Double-click the Arduino icon (you'll find it inside the Arduino folder).



Select Tools→Board→Arduino Uno, as shown in Figure 2-6. If you are using a different model of Arduino, select it instead.
[image: Arduino board selection]

Figure 2-6. Arduino board selection

Select File→Sketchbook→Examples→1. Basics→Blink. This example code flashes the LED on the Arduino pin 13 (the Uno includes an onboard LED connected to pin 13).
Determine which serial port Arduino is using:
	Windows
	Open the Start menu, right-click the computer icon, and select Properties. System Properties will open. On Windows XP, click Hardware. On Vista or Windows 7, look in the list of links to the left. Select Device Manager from the list and open the "Ports (COM & LPT)" node. See which COM port is marked as a USB COM port, as shown in Figure 2-7.
[image: Determine the correct port]

Figure 2-7. Determine the correct port


	Linux and Mac OS X
	With the Arduino unplugged from your computer, select Tools→Serial Port in the Arduino development environment, and observe the list of serial ports listed (such as /dev/ttyUSB0 in Linux or /dev/tty.Bluetooth-Modem in Mac OS X). Dismiss the menu by clicking elsewhere onscreen.
Plug the Arduino in and choose the same menu options again (Tools→Serial Port). Observe which serial port appeared. You've figured out which serial port your Arduino is using.



In the Arduino development environment, select Tools→Serial Port and choose the port you found in the previous step.
Click the icon with the right-pointing arrow in a square box, or choose File→"Upload to I/O Board." The Arduino transmission lights will flash briefly, and you should see the message "Done uploading."
Now you should see the yellow LED labeled L on the Arduino board flashing (see Figure 2-8). This means you have successfully installed the Arduino development environment and uploaded your first Arduino program to the microcontroller. If the light is not flashing, follow the instructions again to see where the installation went wrong. You cannot proceed if this does not work. If you continue to have problems, see the online Arduino troubleshooting guide at http://www.arduino.cc/en/Guide/Troubleshooting.
[image: The LED on pin 13]

Figure 2-8. The LED on pin 13

You might want to come back to this section and run through these steps if you have problems working with Arduino in the future; the Blink example is a good test to ensure that Arduino is working. If the LED does not flash, it's a good time to make sure the cord is plugged in, or determine whether your computer or the Arduino is having problems. Once you establish that something as simple as blinking an LED works, it will be easier to solve the more complex problems later.




End of sample




    To search for additional titles please go to 

    
    http://search.overdrive.com.   


OEBPS/httpatomoreillycomsourceoreillyimages803727.png.jpg
00 00 ©©






OEBPS/httpatomoreillycomsourceoreillyimages803491.png.jpg
LED Pin 13
Transmit/receive  Reset button |
indicator lights |

Power in
Ground
Ground —

\ L& +5Vout
[ &

Digital pins

Analog
inputs

+3,3V out

Mini-B USB connector





OEBPS/httpatomoreillycomsourceoreillyimages803531.png.jpg
B

©





OEBPS/httpatomoreillycomsourceoreillyimages803621.png.jpg
e
|[r1ﬁg£ N (O)@:
'."3

L1X8 F rdl ino
» '-.53‘ Dtécim.l
2 S -






OEBPS/httpatomoreillycomsourceoreillyimages803731.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages803625.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages803715.png
sketch_aug25a +»






OEBPS/httpatomoreillycomsourceoreillyimages803927.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages803667.png





OEBPS/httpatomoreillycomsourceoreillyimages803835.png
File Edit Run Source Refactor Nevigate Search Project W
Bad i H-0-@-

=0
PN S K20 |

4 @ Hmscspeoaus Oniine
I comgoogieandroidappsupioader 458






OEBPS/httpatomoreillycomsourceoreillyimages803803.png
ol o| = .
5 d o =| x| 5| ~
= N ~| D o 2
<4 | _ 1
~ = M n|l = O >
<| x| w0
L p /u m| w| ol X| ®
NEFNE
| of <|<=

Hl @ 4:14Pm






OEBPS/httpatomoreillycomsourceoreillyimages803693.png





OEBPS/httpatomoreillycomsourceoreillyimages803865.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages803687.png.jpg
jemo o [E[=

Microsoft Yindows LUersion 6.1.76001

[Copyright (c> 2009 Microsoft Corporation. A1l rights reserved.

c:\>gtk-deno

@ GT- CodeDemos
Widget (double cick for dema) | Info | Source |
j pplication main window
| Assistant
IDemonstrates a typical application window with menubar,
Builder toolbar, statusbar.

Button Boxes

Change Display

o
E
e





OEBPS/httpatomoreillycomsourceoreillyimages803875.png





OEBPS/httpatomoreillycomsourceoreillyimages803809.png.jpg
0000

(@ e
5000

1 2 |3 [a [s [6 |7 |s |s [o ]
o Jw [ [r |1 v [u i jo[e |
4 |s Io [e Jo [u [y |k 1 [

2]z [x [c v [o v [w[. [&]
[ [wlo | [/ ]|





OEBPS/httpatomoreillycomsourceoreillyimages803719.png
slideShow § +»

char inByte = myPort.readChar():

if (inByte )i
advanceslide()

)

if (inByte )i

reverseslide():

nextInage = loadluage (dataPath{™") + fileList[ingIndex]);
nextInage. resize (0, )






OEBPS/httpatomoreillycomsourceoreillyimages803483.png





OEBPS/httpatomoreillycomsourceoreillyimages803447.png.jpg
Voltage, (DC) (V)

CALTEK
INSTRUMENT

cmMm1100

Continuity
Are the two points connected?
-The meter beeps if they are

Specifying a range
“Thevalues speciAe Uketauae o
thevalue to be measured

Resistance (Ohm, Q)
~An alternativ to translating resistor color
codes





OEBPS/httpatomoreillycomsourceoreillyimages803965.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages804057.png
nhWNHOOONOU A WE

package fi.sulautetut.android, thlueclient;|

inport
inport
inport

inport
inport
inport
inport

public

P

java. io. T0Exception;
java. io. Inputstrean;
java. io. Outputstream
Java. util.uI;

android. bluetooth. Bluet|
android. bluetooth. Bluet]

Tl The declared package "M sulautetutandroid tiueclient” does not match the expected package

2 quick fixes available:

#, Move TBlue java' to package,
H Remove package declaration)

‘fLsulautetut android thlueclient:
Kage fisulautetut androld tbiueclient’

L=l

android. bluetooth. Bluet
android. util.Log

class TBlue {
11






OEBPS/httpatomoreillycomsourceoreillyimages803777.png
Javal- Eclipse SDK

File Edit Bun Source Navigate Search Project Refactor Window Help

=8

|a |86 @30 a|sae |

& gen [Generats
= Android 2.1-u
& assets

Eres

4 AndroidManif
default.proper

W >
Go Into
‘Open in New Window
Open Type Hierarchy F4
Show In Shift+AILFW >
Copy ctri+c
Copy Qualified Name
Paste ctri+v
Delete Delete
Shift+Alt+S >
Shift+AIt+T >

Link Source...
New Source Folder...

Use as Source Folder
Add Extemal Archiyes...
Add Libraries...

Refresh
Close Project






OEBPS/httpatomoreillycomsourceoreillyimages803721.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages803703.png





OEBPS/httpatomoreillycomsourceoreillyimages803513.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages803535.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages803847.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages803575.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages803657.png
Arduino






OEBPS/httpatomoreillycomsourceoreillyimages803737.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages803957.png
© I adea dmice

[el@] = |

OO [ wrar > ez

This device has been successfully added to this computer

Windows is now checking for drivers and willinstall them if
necessary. You may need to waitfor this to finish before your dej
s ready to use.

To verify i this device finished installing properly, look for it in
Devices and Printers.

~ 49| [searchDev 0]

15 Standard Serial over Biustooth link (COM8) Ports (COM ...

Device Function Summary

Manufacturer:  Microscft

| Location:  on Blustooth Device (RFCOMM Protocol TDI)
Device status: This device fs working properly.

() |

Addadevice  Addaprinter  Remove device =2 @
4 Devices (5) -
3 Fircfly-277E Properties o
General | Hardware | Services | Bluetooth - E
Jjﬂ FireFyy-277E
Device Functons: e 2776
Name. Tive






OEBPS/httpatomoreillycomsourceoreillyimages803959.png
Bluetooth Setup Assistant

Welcome to the Bluetooth Setup Assistant.

When your device appears in the list, select it and click Continue. If
you don't see your device in the list, make sure it is powered on and

“discoverable.” For more information, see the documentation that
came with your device.

Devices

Type
FireFly-277E

Unknown

% Updating device name.





OEBPS/httpatomoreillycomsourceoreillyimages803829.png
DDMS - beao8boxingClockReady/AndroidMani

Help

A Ec R St Wi
v @6 6|88 4| ar s

& &leve §llustcode [FDONS] jeve

(T e

% Threads (: =D (: Alocation Tracke

%8 & 0|3 2|0~

=

B ] >
& Emuiator Control 53 =
Telephony Status. 2

Name. size| D
> @ data E
> @ mnt 1
b @ system F

Femmy Actions.






OEBPS/httpatomoreillycomsourceoreillyimages804015.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages803557.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages803817.png





OEBPS/httpatomoreillycomsourceoreillyimages803767.png
Security Warning

Waning: You are installing software that
contains unsigned content. The authenticity or
validity of this software cannot be established.
Do you want to continue with the installation?

\q Details >> Cancel






OEBPS/httpatomoreillycomsourceoreillyimages803717.png
slideShow -
77 Load the current image and resize it. A
currentInage = loadlnage (dataPath(™") + filelist[0]];
currentInage. resize (0, )
/7 List all the available serial ports:
/7% 0n some computers, Arduino will usually be comected to
the First serial port. If not, change the 0 to the
correct one (examine the output of the previous line
of code to figure out which one to use]. */
myPort = new Serial(this, Serial.lisc()[0], 9600);
)
77 6o to the next inage ”
>






OEBPS/httpatomoreillycomsourceoreillyimages803515.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages803537.png.jpg





OEBPS/httpatomoreillycomsourceoreillyimages803961.png
Bluetooth Setup Assistant

Attempting to pair with “FireFly-277E".

Your device may ask you to enter a passkey. Check your device to see

ready to accept a passkey. When your device is ready, enter in

the following passkey:

Once you have entered the passkey on your device the pai
will be completed.

A

The pairing attempt was unsuccessful. The device is refusing the
pairing attempt. Refer to the manual that came with the device. When
ready, click Continue to try again.

(Passcode Options.— (Comae) (o)
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New Android Project

New Android Project

Creates a new Android Project resource.

Project name: |Acceleration

Contents

@ Create new project in workspace
Create project from existing source

[ Use default location

Create project from existing sample
samples:
Build Target

Target Name Vendor
@ Android 2.1-update1 Android Open Source Project

Browse.

Platform  APILev

2.1-update’ 7
Properties

Applicationname: |Acceleration

Package name: fi.sulautetut.android.acceleration

& Create Activity: |Acceleration

Min SDK Version: (7] |
@ <Back | Next> || cancel | ([Finishi]
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Bl Edt Fomet Vew Hep

#! fusr/bin/eny python
# hello.py - print one line, wait for enter
# () Kimno karvinen & Tero karvinen http://sulautetut. fi

print (*Hello python world!”)
raw_irput (“Press enter to continue...”)
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Sketch Help.

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Board

Blink Serial Port

Turns on an LED on for one secq
Burn Bootloader
This example code is in the pub_

// initialize the digital pin as an output.
// Pin 13 has an LED connected on most Arduino bpards:
(13, oUTPUT);

Y
O {
(13, HIGH);  // set the LED on
(1000); /1 wait for a second
(13, LOW);  // set the LED off
(1000); /7 wait for a second
Y

%T |no0021

0 Duemilanove or Nano w/ ATmega328
Arduino Diecimila, Duemilanove, or Nano w/ ATmegal68
Arduino Mega 2560

Arduino Mega (ATmega1280)

Arduino Mini

Arduino Fio

Arduino BT w/ ATmega328

Arduino BT w/ ATmega168

LilyPad Arduino w/ ATmega328

LilyPad Arduino w/ ATmegal68

Arduino Pro or Pro Mini (5V, 16 MHz) w/ ATmega328
Arduino Pro or Pro Mini (5V, 16 MHz) w/ ATmega168
Arduino Pro or Pro Mini (3.3V, 8 MHz) w/ ATmega328
Arduino Pro or Pro Mini (3.3V, 8 MHz) w/ ATmegal68
Arduino NG or older w/ ATmegal68

Arduino NG or older w/ ATmega8
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New Android Project

New Android Project

Creates a new Android Project resource.

Project name: |footballRobot

Contents

@ Create new project in workspace
Create project from existing source

[ Use default location

Create project from existing sample
samples:
Build Target

Target Name Vendor
@ Android 2.1-update1 Android Open Source Project

Browse.

Platform  APILev

2.1-update’ 7
Properties

Applicationname: |Football Robot

Packagename: |fi.sulautetut.android.football

& Create Activity: [Football

Min SDK Version: (7] |
@ <Back | Next> || cancel | ([Finishi]
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New Android Project

New Android Project

Creates a new Android Project resource.

Project name: |TBlueclient

Contents

@ Create new project in workspace
Create project from existing source

[ Use default location

Create project from existing sample
samples:
Build Target

Target Name Vendor
@ Android 2.1-update1 Android Open Source Project

Properties
Applicationname: |Simple tBlue Client

Packagename: |fi.sulautetut.androi

.tblueclient
[ Create Activity: |TBlueClient

Browse.

Platform  APILey
2.1-update’ 7

Min SDK Versior

(

@ <Back | Next> ||
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Review Licenses

Licenses must be reviewed before the software can be installed. This includes licenses for \552'
software required to complete the install.

Items with licenses:

License text:

Name

* Android Development Tools.
@ Eclipse CVS Client

(§* Eclipse CVS Client Resources

(§ Eclipse Help Developer Resources.
(§* Eclipse Help System

§* Eclipse Java Development Tools.

( Eclipse Platform

( Eclipse Project SDK
(§* Eclipse RCP.

G5 Eclipse JDT Plug-in Developer Resource: 3.5.2.r352_v:
(§* Eclipse p2 Provisioning Developer Reso
(§* Eclipse PDE Plug-in Developer Resource

(§ Eclipse Platform Plug-in Developer Resc
(§ Eclipse Plug-in Development Environme

(§ Eclipse RCP Plug-in Developer Resource

[Note: jcommon-1.0.12 jar is under the BSD licens
rather than the APL. You can find a copy of the BS
License at http:/www.opensource.org/licenses/bs
license.php

jfreechart-1.0.9.jar and jfreechart-1.0.9-swt jar ¢
under the LGPL rather than the APL. You can find
Py of the LGPL at http://www.gnu.org/licenses/o
licenses/lgpl-2.1.txt. You can get the source code
hese two components at http://
landroid.git kemel .org/publjfreechart-1.0.9.zip

Apache License
Version 2.0, January 2004
hitp:/www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE,
REPRODUCTION, AND DISTRIBUTION

1. Definitions.

\ccept the terms of the license agreements
not accept the terms of the license agree

wexi> | [ cancel | [ gnish
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